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IMPORTANT!  
THIS AGREEMENT CONTAINS THE LICENSE TERMS AND CONDITIONS AND A GUARANTEE 

FOR THE SATO INTERNATIONAL'S LABEL GALLERY SOFTWARE CONTAINED IN THE 

PACKAGE.  

LOADING THE  SOFTWARE PACKAGE SIGNIFIES YOUR ACCEPTANCE OF THIS 

AGREEMENT. IF YOU DO NOT ACCEPT THIS AGREEMENT, YOU MUST RETURN THE 

SOFTWARE PACKAGE TO YOUR SUPPLIER. 

 

LICENSE 
1. LICENSE GRANT  

Ownership of the SATO International software contained in the enclosed package ("the Licensed 

Software") is not transferred to the Customer. SATO International hereby grants the Customer a 

non-exclusive, non-transferable license to use the Licensed Software on a single computer. If the 

Licensed Software is shared between multiple computer workstations on a network, each 

computer workstation must have its own, separately Licensed Software. 

 

2. COPYING RESTRICTIONS  

The Customer may copy the Licensed Software, in whole or in part, only for backup and archival 

purposes. No more than two (2) copies may be in existence at any time. Each copy shall include, 

in readable format, any and all confidential, proprietary and copyright notices or markings 

contained on the original Licensed Software. 

 

3. CUSTOMER COMMUNICATION OF RESTRICTIONS  

The Customer shall communicate the terms and conditions of this License Agreement to those 

persons employed by the Customer or under the Customer's direction and control who shall use 

the Licensed Software. 

 

 

 

 



 

4. CUSTOMER COMPLIANCE AND UNAUTHORIZED USE 

The Customer agrees to use its best endeavors to ensure that persons employed by the Customer, 

or under the Customer's direction and control, abide by the terms and conditions of this License 

Agreement including, without limitation, not knowingly permitting anyone to use any portion of 

the Licensed Software for the purpose of deriving its source code. If the Customer becomes 

aware that the Licensed Software is being used by such persons in a manner not authorized by 

this Agreement, the Customer shall immediately use its best endeavors to have such unauthorized 

use immediately cease. The Customer shall notify SATO International in writing of the 

unauthorized use in the event that such unauthorized use continues for an unreasonable period 

after the Customer becomes aware of it. 

 

5. THIRD PARTY SOFTWARE 

The Licensed Software is protected by Copyright and other proprietary rights of SATO 

International and, depending upon the Licensed Software provided, of a third party. The 

Customer may be held directly responsible by such third party for acts done by the Customer or 

on its behalf in relation to the Licensed Software which are not authorized by this Agreement. 

 

6. LIMITED WARRANTY  

SATO International makes no guarantee that the operation of the Licensed Software will be 

uninterrupted or error-free, or that the Licensed Software will meet the Customer's requirements, 

or will operate in the combination chosen by the Customer. 

 

7. DISCLAIMER  

SATO INTERNATIONAL GRANTS NO OTHER WARRANTIES ON THE LICENSED 

SOFTWARE AND ANY LIABILITY OF SATO INTERNATIONAL FOR BREACH OF ANY 

OTHER WARRANTY OR  CONDITION, EXPRESS OR IMPLIED, WHETHER BY 

STATUTE OR OTHERWISE, INCLUDING ANY LIABILITY FOR INDIRECT OR 

CONSEQUENTIAL LOSS OR DAMAGE (INCLUDING LOSS OF DATA) ARISING OUT 

OF OR IN CONNECTION WITH THE USE OF THE LICENSED SOFTWARE IS HEREBY 

EXPRESSLY EXCLUDED. SATO INTERNATIONAL FURTHER DISCLAIMS ANY 

WARRANTIES OR REPRESENTATIONS MADE BY PERSONS OTHER THAN SATO 

INTERNATIONAL (INCLUDING BUT NOT LIMITED TO SATO SUBSIDARIES, 

DISTRIBUTORS AND DEALERS). 
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www.satoworldwide.com 
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described in this document is furnished under a license agreement or nondisclosure 
agreement. The software may be used or copied only in accordance with the terms 
of those agreements. No part of the publication may be reproduced, stored in a 
retrieval system, or transmitted in any form or any means electronically or 
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1. Introduction 

1.1 Welcome to Pocket Label Gallery 

Thank you for choosing Pocket Label Gallery, the industry’s leading bar 
code labeling and printing software for Windows-based mobile devices! 

This guide introduces you to using Pocket Label Gallery and printing bar 
code labels through mobile devices. You will learn how to install and 
register Pocket Label Gallery software on your mobile device, design labels 
with Label Gallery and GalleryFrom on your desktop computer, transfer 
the label files to your mobile device, and print bar code labels with mobile 
thermal printers or through a server-based network environment. 

1.2 Pocket Label Gallery Overview 

Pocket Label Gallery enables you to create robust data entry screens for 
your Mobile Device. With the help of Pocket Label Gallery users can print 
bar code labels directly with Windows Mobile Devices that are connected 
with thermal printers through WiFi, Bluetooth, Infrared or serial cable. In 
addition, Pocket Label Gallery enables bar code label printing in a network 
environment. Using GalleryWatch, you can print bar code labels to a 
centralized print server that handles printing and driver selection. Pocket 
Label Gallery and centralized printing through GalleryWatch (called 
Distributed (Print Server) Printing Method) offer a truly mobile distributed 
printing application. 

Pocket Label Gallery can also be used as a print engine (ActiveX server) to 
enable other applications on your Mobile Device to control label printing 
functions. Using Pocket Label Gallery as a print engine appeals to system 
integrators and software developers who wish to utilize Pocket Label 
Gallery as a label printing module for their mobile applications. For more 
information about utilizing Pocket Label Gallery as a print engine in a 
customized mobile Windows application, please see the Label Gallery Web 
site at www.satoworldwide.com   
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1.3 Label Gallery Editions Supporting Pocket Label 
Gallery 

Pocket Label Gallery is part of Label Gallery TruePro that is dedicated to 
simple mobile printing application design: It enables mobile printing 
through a direct connection to mobile printers (direct printing method) and 
client/server connections with server based database lookups (distributed 
(print server) printing method). 

1.3.1 Label Gallery TruePro 

Label Gallery TruePro enables you to create mobile printing applications 
that print directly from the Mobile Device to the printer or through a server 
when used with the GalleryWatch print server. Label Gallery TruePro 
includes all features of Label Gallery Pocket PC Designer plus the 
following: 

�  GalleryForm:  A full version of the standard GalleryForm that will 
allow rapid user interface design for a Mobile Device as well as for a 
desktop PC. 

�  GalleryWatch:  A centralized print server for automating label 
printing operations. GalleryWatch accepts a print request from any 
mobile wireless, desktop, ERP or WMS application to automate label 
printing without user intervention. Print requests can be made 
through a file drop, TCP/IP socket, COM port or email trigger. 

�  GalleryMemMaster:  Utility to download true type fonts and 
graphics to a printer's internal memory to enhance printing 
performance for thermal printers. 

1.4 Setup and Test Mobile Device 

Before you can install Pocket Label Gallery, you have to familiarize 
yourself with your Mobile Device. You must know what processor type 
and what Windows CE operating system your device uses. In addition, you 
have to establish functioning communication between both your desktop 
computer and your Mobile Device through an established ActiveSync 
partnership and between your Mobile Device and a (thermal) label printer 
through serial cable, WiFi, Infrared or Bluetooth.  



 Chapter 1: Introduction 

 

 

Pocket Label Gallery Quick Start Guide 5 

Please refer to the documentation of your Mobile Device to learn more 
about processor, operating system and how to establish different 
communication modes. 

1.5 About this Manual 

The Pocket Label Gallery Quick Start Guide helps you design and print 
labels quickly with a Mobile Device. The Pocket Label Gallery Quick Start 
Guide is an excerpt of the complete Label Gallery User Guide that you can 
obtain on the Label Gallery CD or online at www.satoworldwide.com  

1.5.1 Typographical Conventions 

Text that appears in bold refers to menu names, file names like 
SETUP.EXE and buttons like the OK button. 

Text that appears in italic refers to confirming actions like Read only and 
locations like Folder. 

Text enclosed in <Less-Than and Greater-Than signs> refers to keys from 
the desktop PC keyboard like <Enter>. 

Variables are enclosed in [brackets] like [variable]. 
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2. Installing Pocket Label Gallery 

Before you install Pocket Label Gallery, make sure you have the following: 

�  Label Gallery CD-ROM 

�  Pocket Label Gallery Quick Start Guide  

�  Client Access License Number (10-digit Serial Number) 

2.1 System Requirements  

To work with Pocket Label Gallery, you need to have the following: 

1. Desktop PC to design labels and forms meeting the following 
requirements: 

�  Pentium based computer with at least 64 MB of free RAM. 

�  One of the 32-bit Windows operating systems: Microsoft Windows 
98 SE, ME, NT, 2000, XP or 2003. 

�  Hard disk with 50 to 205 MB of free disk space (depending on the 
installation options). 

�  CD-ROM drive. 

�  Support for OLE DB database drivers. Recent Windows operating 
systems have included OLE DB database drivers. If your operation 
system does not have the database support, the installation wizard 
will prompt you to install it. 

�  Administrator rights to the local computer during installation. 

2. Windows Mobile Device meeting the following requirements: 

�  At least 8 MB RAM  

�  Installed ActiveSync Version 3.5 or higher 

�  One of the following Windows operating systems: 

�  Pocket PC 2000, 2002 and 2003 

�  WinCE 3.0 
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�  CE.NET 

3. GalleryDrivers  

�  Required for Direct Printing Method 

�  Not Required, but recommended for Distributed (Print Server) 
Printing Method 

 

2.2 Software Installation 

Please note: If your desktop PC runs Windows NT, 2000 or XP, you have 
to log on with administrator rights to be able to install the software 
properly. Furthermore, you must ensure that your Mobile Device works 
properly, including file synchronization with ActiveSync and any printing 
capabilities your Mobile Device supports. 

There are two ways to install Pocket Label Gallery: You can either follow 
the installation wizard on the Label Gallery CD-ROM or transfer the 
appropriate .CAB file to your Mobile Device manually. 

2.2.1 Installation Wizard 

1. Connect your Mobile Device to the desktop PC.  

2. Make sure that an ActiveSync partnership is established between the 
desktop PC and Mobile Device. 

3. Put the Label Gallery CD-ROM in your CD drive. The 
STARTUP.EXE application will start automatically. If not, go the 
folder ‘X:\’ and click on the file Start.exe (‘X’ stands for the letter of 
your CD-ROM drive). The window Label Gallery Plusduct CD will 
open. 

4. Click on Install . 

5. Click on Mobile Printing Editions (WinCE) . 

6. Click on Pocket Label Gallery and follow the prompts. 

7. Select correct Operating System or Platform for your Mobile Device. 
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Note:  If you select the wrong platform here, you won’t be able to install 
  and register Pocket Label Gallery on your Mobile Device. If you 
are not sure what operating system (or platform) your Mobile Device uses, 
check your documentation or your system information under 
settings/control panel or in the Help menu of your Mobile Device. 

8. Follow the prompts to finish the installation. 

9. If Pocket Label Gallery installation on your desktop PC is complete, 
ActiveSync will start and transfer the necessary files to the Mobile 
Device. Follow the prompts on both the desktop PC and Mobile Device. 

The Pocket Label Gallery application will be stored in the folder \Program 
Files\Pocket Label Gallery. Pocket Label Gallery will also appear in the 
Start\ Program menu of your Mobile Device. 

Installing Pocket Label Gallery using Installation Wizard 
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2.2.2 Transfer .CAB file to your Mobile Device 

Instead of using the installation wizard and starting SETUP.exe from the 
Label Gallery CD-ROM, you can transfer the correct .CAB file to the 
Mobile Device by doing the following: 

1. Create a synchronization folder for your Mobile Device on your desktop 
PC. [You might have done that already when you setup the 
communication between your desktop PC and Mobile Device.] 

2. Put the Label Gallery CD-ROM in your CD drive and go to the folder 
X:\Setup\WindowsCE (‘X’ stands for the letter of your CD-ROM drive) 

 
 

 

3. Open the folder with the name of the Operating System or Platform of 
your Mobile Device. 

4. Select the .CAB file that mentions your Operating System or platform 
before the .CAB extension.  

5. Copy that file to your synchronization folder for your Mobile Device. 

Installing Pocket Label Gallery 
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6. Transfer the .CAB file to your Mobile Device using ActiveSync. 

Complete installation on your Mobile Device: 

7. Open ‘File Explorer’ and select the transferred .CAB file on your 
Mobile Device.  

8. Tap or open the file (depends on your Mobile Device) and follow the 
prompts on the screen of your Mobile Device. 

The Pocket Label Gallery application will be stored in the folder \Program 
Files\Pocket Label Gallery. Pocket Label Gallery will also appear in the 
Start\ Program menu of your Mobile Device 

2.3 Demo Mode 

After you have installed Pocket Label Gallery on your Mobile Device, 
Pocket Label Gallery will open in DEMO mode. The DEMO version of 
Pocket Label Gallery allows you to print only one (1) variable field per 
label. You will also see a DEMO warning between each print request. 

Please note that you should use the DEMO version only to evaluate the 
software. Any commercial use of the DEMO software is prohibited. To 
obtain the full working version of Pocket Label Gallery, you have to 
register the software with the 10-digit Client Access License (CAL) 
number provided at the time of purchase of Pocket Label Gallery. 
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3. Registering Pocket Label 
Gallery 

The licensed version of Pocket Label Gallery comes with a 10-digit Client 
Access License (CAL) number that releases the application from DEMO 
mode and enables you to print labels without limitations from your 
Windows Mobile Device. 

To register Pocket Label Gallery on your Windows Mobile Device, do the 
following steps: 

1. Open Start/ Programs/ Pocket Label Gallery folder/ Pocket Label 
Gallery (or Pocket GalleryForm). 

2. Read the DEMO warning and tap the YES button. 

 
 

 

3. Enter the required information into the registration dialog box on the 
Mobile Device and tap the REGISTER button. 

 

Demo Warning Pocket Label Gallery 
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Registering Pocket Label Gallery with your Mobile Device will remove the 
DEMO mode limitations. The CAL number you received with your initial 
Label Gallery TruePro with WindowsCE support is only valid for one (1) 
Mobile Device. If you want to use Pocket Label Gallery with more than 
one Mobile Device, contact your reseller to upgrade the Client Access 
License for multiple devices. 

Registering Pocket Label Gallery 
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4. Designing Labels for Pocket 
Label Gallery 1 

Creating a label for your Mobile Device requires two steps: First, you need 
to design a label or form with Label Gallery Plus or GalleryFrom on your 
desktop PC first. Second, you need to transfer the label or form to your 
Mobile Device. To learn more about the differences between labels and 
forms designed with Label Gallery Plus and GalleryForm, go to the Label 
Gallery Web site at www.satoworldwide.com and see the Label Gallery 
User Guide (under Downloads/ Manuals) or tutorials (under Support). 

The following section will discuss how to design labels and forms for 
Pocket Label Gallery using both Label Gallery Plus and GalleryForm. 

 

TIP:  Before you start designing a label, create a synchronization folder
  on your desktop where you save your label for the Mobile Device. 
  You will synchronize the files in the synchronization folder with 
  your Mobile Device. 

 

Note on printing method: Before you start designing the label for you 
Mobile Device using Label Gallery Plus, make sure you understand the 
different label design restrictions between the Direct Printing Method  and 
the Distributed (Print Server) Printing Method . 

 

Direct Printing Method:  You print labels directly from the Mobile Device 
that is connected to the printer through Bluetooth, IR, WiFi, or serial cable. 
With the direct printing method consider the following requirements when 
you design your label: 

Only text and bar code objects can be linked to variables. 

                                         
1 The following instructions base on and were tested with Unitech Windows CE .Net Mobile Device and Sato CL408e 
printer. 
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Only use native (SATO Printer) fonts for all the variables on the label. 
Exporting to Pocket Label Gallery does not support variables in true type 
font (unless you use GalleryMemMaster to download true type fonts and 
graphics to your printer's internal memory to enhance printing performance 
for thermal printers. See Online Help of the GalleryMemMaster module for 
more information). 

Use only printer internal counters on the label. Exporting to Pocket Label 
Gallery does not support Label Gallery variable counters. 

Select the printer you will print the labels with in the field at the time you 
design the label. The generated .PNL file only works with the selected 
printer because the native language compliance is required at the time of 
label design. 

 

Distributed (Print Server) Printing Method:  You print labels from the 
Mobile Device to GalleryWatch, which handles printing and enables 
selection of different printer drivers. Pocket Label Gallery becomes a client 
to GalleryWatch. When you design a label using the print server method, 
you can use true type font for both fixed text objects and objects using 
variables. 

4.1 Supported Functions in Pocket Label Gallery 

Pocket Label Gallery supports the following functions: 

�  Concatenation 

�  Currency Exchange 

�  Date Addition 

�  Internal Printer Counters 

�  Internal Printer Clock (Date/ Time) 

�  EAN.UCC 128 

�  Linear 

�  Subset 
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Label Gallery Design – Data View 

4.2 Design Mobile Device Labels with Label Gallery 
Plus 

Open Label Gallery Plus on your desktop computer and design a label 
using the following objects2: 

�  Text objects with Fixed Text in true type fonts. 

�  Text objects with Keyboard Input variables in native font. 

�  Bar Code object with Keyboard Input variable. 

�  Text object with New Date Field in native font. 

�  Fixed Picture object. 

 

 

 

 

Note:  All text objects using keyboard input variables (Prompts 1-4 and 
Date 1) must use printer native fonts in order to work with 
 Pocket Label Gallery. Label Gallery shows all native font types 

                                         
2 For more detailed information on how to design labels using Label Gallery Plus, look at the Label Gallery Quick Start 
Guide (included in your product box or available as a PDF file on your Label Gallery CD or at the Label Gallery Web 
site at www.satoworldwide.com). 
 

Text Object  
(Keyboard Input; 
Printer Native Font) 

Fixed Picture  

Date Field Object  
(Text Object, Key-
board Input; Printer 
Native Font) 

Fixed Text 
Object 
(True Type Font) Bar Code Object  

(Keyboard Input; 
Printer Native Bar 
Code) 
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Label Gallery Plus  – Printer Native/ Resident Font 

with a printer icon in the font name drop down menu (see figure 
below). 

  In addition, make sure you select the printer you want to print the 
  label with your Mobile Device at the time you design the label.  
  You have to install the printer driver (GalleryDriver) on the  
  computer you design the label with even though the printer is not 
  connected to that computer. 

 

 

 

 

 

 

 

 

 

 

 

4.3 Synchronize Labels with ActiveSync 

After you have designed your label, you need to synchronize the label with 
your Mobile Device. If you have not done so already, you should create a 
synchronization folder on your desktop where you save your label for the 
Mobile Device.  

Synchronize the files in the synchronization folder with your Mobile 
Device by doing the following steps: 

1. Save the open label file on your desktop. 

Native Font Menu   
(Printer icon 
indicates native 
fonts of the 
selected printer) 
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Exported Files on Mobile Device 

2. Go to File/ Export/ Export to Pocket PC… 

An Information window will open telling you that the export function 
 has been completed successfully. 

3. In the folder My Labels/ Labels, copy the two label files with the 
suffixes .LVR and .PNL to the synchronization folder of your Mobile 
Device. 

 
 

4. Connect and synchronize your Mobile Device with your desktop 
computer. 

5. Open the folders My Documents/ My Label on your Mobile Device and 
check if both .LVR and .PNL files have been synchronized successfully. 

 

 

 

 

 

 

 

 

 

 

 

Exported Pocket Label Gallery Files 
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You should now be able to open and print the label with your Mobile 
 Device using Pocket Label Gallery. 

Note: You cannot change the label using Pocket Label Gallery on your 
 Mobile Device. If you want to change the label for your Pocket 
 Label Gallery, you have to make the changes with Label Gallery 
Plus on your desktop computer, export the revised file and transfer 
it to the Mobile Device again. Make sure that you delete the old 
file from the memory of your Mobile Device first before you 
transfer the new label (.PNL and .LVR) files from your desktop 
computer to the Mobile Device. 

4.4 Design Mobile Device Label with GalleryForm 

This section will discuss how to use GalleryForm to design a basic Mobile 
Device label and a Mobile Device label connected to a database. You can 
create a form both ways: either start with a blank form and create the form 
manually or use a label template created with Label Gallery Plus first and 
convert the template to a form.  

The following section uses a label template created with Label Gallery Plus 
as the starting point for creating a form. The form will use Combo Boxes 
for the existing variables so that the operator in the field can select the data 
from a pre-defined drop-down menu. 

 

Note: If you design a form for Pocket GalleryForm, your Mobile Device
  determines what features of GalleryForm can be used or not. In  
  general, all Pocket Label Gallery certified Mobile Devices support 
  the following GalleryForm objects and features: 

�  Text, Button, Edit Field, Memo Field 

�  Combo Box and List Box 

�  Table 

�  Database Navigator and Database Search 
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Form Based on Label Template 

4.4.1 Design a Basic Form  

To design a basic form, do the following: 

1. Open GalleryForm. 

2. Start the  New Form Wizard or go to the File menu and select New/ 
New Form Wizard. The New Form Wizard will open.  

3. Read the summary and click on the Next button. 

4. Select Mobile Windows application and select the platform (VGA 
screen size) of your Mobile Device. Click on the Next button. 

5. Click on the  button and browse to the label template you created 
with Label Gallery Plus (here: pocketlg-label.lbl).  

6. Select Use default template. A new window will open. 

7. Select Vertical arrangement of the object and click on the Next button. 
A new window will open. 

8. Select Top arrangement of the captions and click on the Next button. A 
new window will open summarizing your selection. 

9. Click Finish to submit the settings and the form will be generated. A 
new window opens showing the form similar to the figure below:  

 

 

 

 

 

 

 

 

 

 

Note:  The form shows the 5 Keyboard Input prompts and created 
   as a default feature three additional objects: Quantity 
   Keyboard Input object, Print and Quit buttons. 

 

Variable Text Objects  
Prompts 1-5 

Edit Field and Buttons  
Added by GalleryForm 
automatically. 
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10. Save the form by clicking on the  button or select command Save 
from the File menu. 

Note: All forms for Pocket GalleryForm are saved as an .OFF file. 

 

TIP:   If the printer you selected on the label template is connected to  
  your desktop computer, test printing the form from your desktop 
  computer and do the following: 

a. Run the form by clicking on the  button or selecting the 
Run command in the Design menu. 

b. Type in the values for the variable fields on the form. See how 
the label preview refreshes for each entered data.  

c. Click on the Print  button to print the label to the default 
printer.  

d. Click on the Quit  button to close the running form. 

4.4.2 Create Combo Box on the Form 

Change the Variable fields on the label template to Combo Box fields 

Before you synchronize the form with your Mobile Device, replace 
prompts 1-4 with a Combo Box. A Combo Box has a defined list of values 
you can select to print on the label. The only variable field that will not be 
changed is the Prompt5 variable. You will have to enter the information for 
that field manually (or scan) at print time. Using a Combo Box makes 
keyboard entry in the field with the Mobile Device easier and faster than 
typing each value with the keyboard tab. 
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To create a Combo Box, do the following steps: 

1. From the Toolbox menu, select Combo Box/ Use Existing Variable/ 
Prompt1 and click on the form. 

 

 

 

 

 

 

 

 

 

 

 

 

2. Double-click on the Combo Box you placed on the form and a window 
with the Combo Box Properties will open. 

3. Open Contents tab and select Variable Value and Prompt1. 

4. Open Values tab and click on the Edit  button. A new window Edit 
Items will open. Do the following: 

 

a. Select Use Custom Values in the drop-down menu. 

b. Enter the list of items you want to 
select from at print time (one item 
per line). 

c. Click on OK button twice. 

5. Replace (delete) the original variable field 
with the new Combo Box. 

6. Repeat steps one (1) to five (5) for the 
variable fields showing prompts two (2) to 
four (4). 

Create Combo Box 

Form With Combo Boxes In Run-Mode 
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Access Database with 3 Tables 

7. Save the form by clicking on the  button or select Save from the File 
menu. 

Note: All forms for Pocket GalleryForm are saved as an .OFF file. 

 

TIP:   If the printer you selected on the label template is connected to  
  your desktop computer, test printing the form from your desktop 
  computer and do the following: 

a. Run the form by clicking on the  button or selecting the 
Run command in the Design menu. 

b. Type in the value for the first variable field (Prompt5) and 
select the item from the Combo Boxes.  

c. Click on the Print  button to print the label to the default 
printer.  

d. Click on the Quit  button to close the running form. 

4.4.3 Design Form with Database Connection 

You can link a form to any kind of database or Excel spread sheet, 
synchronize the form and database files to and print the form with your 
Mobile Device. To design the form for you Mobile Device which is 
connected to a database, do the following steps: 

a) Create a Microsoft Access database with three (3) tables: Label Gallery 
Products, Label Gallery Version and Hardware Key. 

b) Link the Combo Text objects on the form to the database. 
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Create a Microsoft Access Database with the following tables and content: 

1. Table Hardware Key: None, USB Key, Parallel Key 

2. Table Label Gallery Products with columns for product edition and 
product code (see figure below): LG Free, LG Easy; LG Plus, LG 
TruePro; LG Plus Print Only, LG TruePro Print Only; etc. 

3. Table Label Gallery Version: 1.6.2, 1.6.4, 1.6.5, 2.0.0 

 
 

To connect the form to a database using a Combo Box, you must create 
database access functions that define a link to your database and create 
objects that use the data from the database. 

 

To create database access functions, do the following steps: 

1. Open the form above with GalleryForm. 

2. Go to Data/ Database Access in the menu bar. The window Database 
Access Functions will open. 

3. Click on the Wizard button and a new window will open. 

4. Click on Next and the window Database Wizard – Browse for 
Database file will open. 

5. Select Direct database access and browse for the Access database file 
in your directory.  

Access Database Table Label Gallery Products  
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6. Select HardwareKey in the drop-down menu and click on the Next 
button. A new window will open. 

7. Select I will link the database fields to the objects myself later  and 
click on the Next button. A new window will open summarizing the 
steps you have completed. 

8. Click on the Finish button. The open window Database Access 
Functions will now show the link HardwareKey. 

9. Repeat steps three (3) to eight (8) twice but select Label 
GalleryProducts and Label Gallery Version in step six (6) to create a 
link to all your tables of the database. 

10. When you have established a link to all tables, the window Database 
Access Functions should show all three (3) links. See figure below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

11. Click on the Close button. 

 

 

GalleryForm: Links to Database Tables 
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To link the database tables to a Combo Box on your form, do the following 
steps: 

1. Double click on the Combo Box Prompt1. The window Combo Box 
Properties will open. 

2. Open tab Values and click on the Edit  button. The window Edit items 
will open. 

3. Select Use database values from the drop-down menu. 

4. Select Label Gallery Products under Database und Product Edition 
under Field and click on the OK button. The values tab in the window 
Combo Box Properties will show all the values of your database table. 

5. Click on the OK button. 

6. Repeat steps two (2) to six (6) with the Combo Box objects of prompts 
two (2) to four (4) and connect to the correct table of your database. 

7. Save the form by clicking on the  button or select command Save 
from the File menu. 

 

TIP:   If the printer you selected on the label template is connected to  
  your desktop computer, test printing the form from your desktop 
  computer and do the following: 

a. Run the form by clicking on the  button or selecting the 
Run command in the Design menu. 

b. Type in the value for the first variable field (prompt5) and 
select the item from the Combo Boxes.  

c. Click on the Print  button to print the label to the default 
printer.  

d. Click on the Quit  button to close the running form. 

 

You can also link the form to an XLS file with multiple worksheets. The 
equivalent to the Access database above with three tables would be an XLS 
file with three  worksheets named Hardware Key, Label Gallery 
Products and Label Gallery Version. 
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Note: You cannot change the form using Pocket Label Gallery on your 
  Mobile Device. If you want to change the form or the database for 
  your Pocket GalleryForm, you have to make the changes with  
  GalleryForm and the database program on your desktop computer 
  and transfer the revised form file to the Mobile Device again.  
  Make sure that you delete the old form file from the memory of  
  your Mobile Device first before you transfer the new form (.OFF) 
  file with the Synchronization Manager. 

4.5 Synchronize Forms with ActiveSync 

You have two options to synchronize your form (.OFF) files from your 
desktop computer with your Mobile Device: You can either copy the form 
(.OFF) file to the synchronization folder of your Mobile Device (see 
chapter Synchronize Labels with ActiveSync), or you can transfer the 
form (.OFF) file to your Mobile Device using the Synchronization 
Manager.  

 

Note:  The following synchronization method only works with form  
  (.OFF) files that do NOT have objects linked to a database. 

 

If you have not done so already, you should create a synchronization folder 
on your desktop where you save your label/ form for the Mobile Device. 
You will synchronize the files in the synchronization folder with your 
Mobile Device.  

To synchronize the form (.OFF) file with your Mobile Device, do the 
following steps: 

1. Open the directory where your GalleryForm saved your form (.OFF) 
file. The default location is C:\My Documents\My Labels\Form. 

2. Select the form (.OFF) file you want to synchronize and copy it to your 
Synchronization folder (here: pocketnl-form.off). 
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3. Open Label Gallery Plus and open the .LBL file (here: pocketlg-
label.lbl) that is the label template for the form (.OFF) (here: pocketlg-
form.off ) file. 

4. Go to File/ Export/ Export to Pocket PC… An Information window 
will open telling you that the export function has been completed 
successfully. 

5. In the folder My Labels/ Labels, copy the two label files with the 
suffixes .LVR and .PNL to the synchronization folder of your Mobile 
Device. 

 
 

 

 

Form (.OFF) File in Form Folder 

Exported Pocket Label Gallery Files 
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Your synchronization folder should have the following files: 

  
 

6. Connect and synchronize your Mobile Device with your desktop 
computer. 

7. Open the My Label folder (in the My Documents folder) on your 
Mobile Device and check if all the .OFF, .LVR and .LVR files have 
been synchronized successfully. 

 

 

 

 

 

 

 

 

 

 

 

 

You should now be able to open and print the form with your Mobile 
 Device using Pocket GalleryForm. 

 

Synchronization Folder 

 
Synchronized Files on Mobile Device 
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Note: You cannot change the form (.OFF) file using Pocket 
GalleryForm on your Mobile Device. If you want to change the 
form, you have to make the changes with GalleryForm on your 
desktop computer and transfer the modified form (.OFF) file to 
the Mobile Device  again. Make sure that you delete the old file 
from the memory of your Mobile Device first before you transfer 
the new form (.OFF) file from your desktop computer to the 
Mobile Device. 

4.6 Synchronize Forms with Synchronization Manager 

If you synchronize .OFF files with your Mobile Device the first time, you 
must add your Mobile Device to the Synchronization Manager first. 

To add a new device to the Synchronization Manager, do the following 
steps: 

1. Connect your Mobile Device to your desktop computer (or put the 
Mobile Device in the cradle). 

2. Open Synchronization Manager in the folder Label Gallery 2/ Utilities. 

A window will open prompting you to connect the new device. 

Note:  If the Add Device Wizard does not start automatically, go 
   to Tools/ Device/ Add in the menu bar. The Add Device  
   Wizard will open. 

3. Follow the prompts and finish the wizard. The left panel in the window 
will show an icon with the name of your Mobile Device (see figure 
below). 
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To synchronize form (.OFF) files with the Synchronization Manager, do 
the following steps: 

1. Connect your Mobile Device to your desktop computer (or put the 
Mobile Device in the cradle). 

2. Open Synchronization Manager in the folder Label Gallery 2 – Utilities 
computer (or put the Mobile Device in the cradle). 

3. Click on the  icon of your Mobile Device (here: 
WindowsCE-Unite). 

4. Click on the  button and browse to the form you created with 
GalleryForm (here: pocketnl-form.off). 

5. Select the file pocketnl-form.off and click on the icon  to add the 
file on the synchronization list. 

6. Close the Desktop Browser window. 

7. In the window Synchronization Manger (in Device Bar on the left side), 
click on the icon of your Mobile Device. 

8. Select the file pocketnl-form.off and click on the icon  or go to 
Tools/ Synchronize to synchronize the file with the Mobile Device. 

 
Synchronization Manager 

Device Bar  
Shows added 
Mobile Devices 

Logging Panel  
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 The Logging Panel (bottom right, see figure above) states that form file 
  is ‘on the Mobile Device’ or the label file (.LBL) ‘converted OK.’ 

9. Open the My Label folder (in the My Documents folder) on your Mobile 
Device and check if all the .OFF, .LVR, .LVR and .PNT files have been 
synchronized successfully. The .PNT files are the exported tables that 
are connected to your form .OFF file. Each table has one .PNT file. 

 

 

 

 

 

 

 

 

 

 

 

 

The folder should show all the synchronized files. 

 
Synchronized Files on Mobile Device 
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5. Printing Labels with Pocket 
Label Gallery 

You must transfer all necessary label, form and database files to your 
Mobile Device before you can print the labels and forms with Pocket Label 
Gallery. Pocket Label Gallery offers three (3) types of label printing 
methods: direct, distributed (print server) and print engine printing method. 

5.1 Direct Printing Method 

With the Direct Printing Method you print labels directly from the Mobile 
Device that is connected to the printer through Bluetooth, IR, WiFi, or 
serial cable. You can print labels (.PNL files) using Pocket Label Gallery 
and forms (.OFF files) using Pocket GalleryForm. 

5.1.1 Select Communication Port between Printer and  Mobile 
Device 

On your Mobile Device, select the port that connects your Mobile Device 
with the printer you want to print the labels. You have five (5) port options 
for the direct printing method:  

�  COM port:  Select this port if your printer is connected to the  
   serial port on the Pocket PC device. Set the required 
   connection parameters. The parameters on the printer 
   should be the same as on the Mobile Device. 

�  LASP port:  Select this port if you want to print over the built-in 
   infrared port. Leave the IR Port setting to 0 for auto-
   detection. The printer IR receiver must be in line-of-
   sight range of the IR port on the Mobile Device. 

�  TCP/IP port:  Select this port if you want to print to the printer  
   using the TCP/IP protocol. Please note that the  
   printer must be equipped with a wireless network  
   card and be connected directly to the network. The  
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   printer must have its own IP address and the port 
   must be known for the incoming connection. 

�  Bluetooth: Select this option if you want to print labels using the 
   Bluetooth wireless protocol. In the Bluetooth 
   properties on the Mobile Device, you must define a 
   mapping to a virtual COM port through the  
   Bluetooth administration tool. Select the appropriate 
   mapped COM port. The printer has to be in range of 
   the Bluetooth printer. Check the operating manual of 
   your Bluetooth device for effective distances. 

�  IrSIR port:   Select this option if you want to print over the built-
   in infrared port. This option is used for printing to  
   SATO MB Series of printers. 

 

To select the port on your Mobile Device using Pocket Label Gallery or 
Pocket GalleryForm, do the following steps: 

1. On your Mobile Device, tap on Start/ Programs/ Pocket Label 
Gallery/ Pocket Label Gallery (or Pocket GalleryForm). Pocket 
Label Gallery (or Pocket GalleryForm) will open. 

2. Tap Options/ Preferences and the window Preferences will open. See 
figure below.  

3. Enter the default folder with the label files on your Mobile Device 
(Pocket Label Gallery uses My Labels on default).  

4. Select the port of your choice. See example in figure below.  
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5. Tap the OK button to close the window. 

5.1.2 Print with Pocket Label Gallery 

To print your label with Pocket Label Gallery, please note that you must 
follow certain requirements when you design your label (.PNL file) for 
Pocket Label Gallery using Label Gallery Plus (see Designing Labels for 
Pocket Label Gallery). 

 

Select printer at the time of label design (Label G allery Plus)  

When you design the label (.PNL file) make sure you select the printer you 
want to print the label with your Mobile Device. The label file will only 
print from the Mobile Device with the printer you selected when you 
designed the label with Label Gallery Plus. Because the Mobile Device 
does not have GalleryDrivers installed you cannot change the printer 
assigned to the label using your Mobile Device with Pocket Label Gallery 
if you use the direct printing method. 

To be able to design the label with the correct printer assigned to it, you 
must install the printer driver (GalleryDriver) on the computer you design 
the label with even though the printer is not connected to that computer. 

 

 
Mobile Device: Communication Ports 
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Print labels with Pocket Label Gallery from Mobile Device  

To print the label with your Mobile Device using Pocket Label Gallery, do 
the following steps: 

1. Export the label files (.PNL and .LVR) to your Mobile Device (see 
above). 

2. On your Mobile Device, tap on Start/ Programs/ Pocket Label 
Gallery/ Pocket Label Gallery. Pocket Label Gallery will open. 

3. Tap File/ Open label/ My Documents/ My Labels/ and select the 
.PNL file (here: pocketnl-label.pnl).  

4. Tap the OK button. You will see the following information on the 
screen:  

 

 

 

 

 

 

 

 

 

 

 

 

5. Tap the printer icon or tap File/Print….  A new window will open 
showing the label with the variable prompts (see figure below). 

6. Enter the required information. You must enter a value for all of the 
variable prompts. 

 

 

 

 
Pocket Label Gallery: Open Label 
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7. Tap the Print  button to print the label 

5.1.3 Print with Pocket GalleryForm 

Pocket GalleryForm offers a very user-friendly method to print labels (here 
forms) with a Mobile Device. You design a file with GalleryForm (on your 
desktop computer) that has a data entry interface or application printing 
interface and includes all possible variable values. The operator in the field 
only has to select the values from a drop-down menu (combo box) to 
initiate a print job with the Mobile Device. Using Pocket GalleryForm 
simplifies data input, reduces input errors and reduces errors in data 
collection and label printing. 

Select form preferences on your Mobile Device  

On your Mobile Device, select the form preferences so that the Pocket 
GalleryForm application overwrites the .OFF file settings by doing the 
following steps: 

1. Tap on Start/ Programs/ Pocket Label Gallery/ Pocket GalleryForm . 
Pocket GalleryForm will open. 

2. Tap Options/ Form preferences… and the window Form Preferences 
will open. See figure below.  

3. Select Overwrite OFF file settings with application preferences.  

 
Pocket Label Gallery: Print Label 
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4. Tap the OK button to close the window. 

 

To print the label with your Mobile Device using Pocket GalleryForm, do 
the following steps: 

1. Transfer the form (.OFF) file with the Synchronization Manger to your 
Mobile Device (see above). 

2. On your Mobile Device, tap on Start/ Programs/ Pocket Label 
Gallery/ Pocket GalleryForm. Pocket GalleryForm will open. 

3. Tap File/ Open form/ My Documents/ My Labels/ and select the .OFF 
file (here: pocketnl-form.off).  

4. Tap the OK button. You will see the following information on the 
screen:  

 

 

 

 

 

 

 
Pocket GalleryForm Preferences 
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5. Tap the run icon (green arrow) or tap File/Run form. A new window 
will open showing the form with the variable combo boxes (see figure 
below). 

6. Enter and select the required information.  

 

 

 

 

 

 

 

 

 

  

 

 

7. Tap the Print  button to print the form. 

 
Pocket GalleryForm: Open Form 

Pocket GalleryForm: Run Form Pocket GalleryForm: Enter Data 
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5.2 Distributed (Print Server) Printing Method 

With the Distributed (Print Server) Printing Method you print labels from 
the Mobile Device to GalleryWatch, which handles printing and enables 
selection of different printer drivers. Pocket Label Gallery becomes a client 
to GalleryWatch, which is the automated label-printing server running on a 
PC or a server.  

Pocket Label Gallery will output a print request that describes the label 
layout and the printing process, encode this information to a JOB file using 
GalleryCommands and send the .JOB file to a file trigger or a TCP/IP 
socket in GalleryWatch. GalleryWatch processes the .JOB file and prints 
the label to any available network printer. 

Using the distributed (print server) printing method allows you to select the 
printer type and format at the time of printing versus at the time of label 
design. Because Label Gallery Plus is running on the print server at the 
same time as the labels are printed, there are no design limitations as 
discussed under the direct printing method. You can use all the Label 
Gallery Plus and GalleryForm functionalities, such as true type font for 
both fixed text objects and objects using variables. 

If you want to use the distributed (print server) printing method, you can 
use either Pocket Label Gallery or Pocket GalleryForm to select the data in 
the field you want to print from a printer on your network. However, using 
Pocket GalleryForm is the recommended application because of its ease-of-
use for the operator in the field. The following sections will focus on the 
distributed (print server) printing method using GalleryWatch, GalleryForm 
and Pocket GalleryForm.  

To set up the distributed (print server) printing method, you need to do the 
following steps: 

�  Select the communication port of your Mobile Device and Print 
Server. 

�  Setup GalleryWatch on your server or computer where the Label 
Gallery software is installed.  

�  Select the correct form (.OFF) file properties. 
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5.2.1 Select Communication Port between Print Serve r and 
Mobile Device 

On your Mobile Device, select the port that connects your Mobile Device 
with the printer you want to print the labels. You have two (2) port options 
for the distributed (print server) printing method:  

JOB file:  A .JOB file will be created and saved to the defined  
 network drive location into a customized filename. The  
 .JOB file contains GalleryCommands describing the label 
you want to print, the network printer you want to use and 
the data for the label. GalleryWatch, which runs on the 
server, will detect the file drop and initiate the .JOB file to 
be processed and printed by the GalleryWatch printing 
server. 

JOB TCP/IP: As discussed with the previous option, a .JOB file is created 
 and then sent to GalleryWatch using the TCP/IP protocol. 
 GalleryWatch accepts the incoming connection on a 
 predefined TCP/IP port and processes the 
GalleryCommands from the file. The GalleryWatch printing 
server will print the labels. 

 

To select the port on your Mobile Device using Pocket Label Gallery or 
Pocket GalleryForm, do the following steps: 

1. On your Mobile Device, tap on Start/ Programs/ Pocket Label 
Gallery/ Pocket Label Gallery (or Pocket GalleryForm). Pocket 
Label Gallery (or Pocket GalleryForm) will open. 

2. Tap Options/ Preferences and the window Preferences will open. See 
figure below.  

3. Enter the default folder with the label files on your Mobile Device 
(Pocket Label Gallery uses My Labels on default).  

4. Select either JOB File or JOB TCP/IP and enter the required 
information for path/ name or host/ port. See example in figure below.  
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5. Tap the OK button to close the window. 

5.2.2 Setup GalleryWatch for Distributed (Print Serv er) Printing 
Method 

GalleryWatch is a module of the Label Gallery TruePro edition that 
monitors events and automatically starts label production when specific 
(trigger) events occur. Trigger events can occur through a trigger file, an 
email, TCP/IP socket connection or COM port activity. GalleryWatch can 
watch up to 99 events each with their own specified action. GalleryWatch 
executes a pre-defined activity, such as label printing through a network 
printer, if one or more of such trigger events occur. You can use 
GalleryWatch and start automatic label production on your computer where 
the Label Gallery software is installed or from your network. 

For a detailed discussion about GalleryWatch, please see the GalleryWatch 
User Guide on our Web site at www.satoworldwide.com  

If you want to print labels on a remote print server using your Mobile 
Device, you can set up GalleryWatch with JOB file or TCP/IP triggers.  

 

 

 
Distributed Printing: JOB TCP/IP 

 
Distributed Printing: JOB File 
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JOB File Trigger  

A .JOB file specifies all the information required to print a label (label, data 
and printer). When you select the data with your Mobile Device and send 
the print job by tapping the print button, GalleryWatch detects the dropped 
file in a specified folder, processes the data and prints the label(s) from the 
GalleryWatch printing server. 

To set up a JOB file trigger with GalleryWatch, do the following steps: 

1. Open GalleryWatch (Go to Tools/ GalleryWatch in the menu bar of 
your open GalleryWatch software). 

2. Select New in the File menu or click on the icon  in the standard 
toolbar. 

3. Save the new configuration file as pnl-nwatch.mis. 

4. In the File menu bar, go to Edit/ Add Trigger/ File…  or click on the 
icon  in the standard toolbar. 

5. Select the following options: 

i. File Trigger Options: enable trigger and select file name of your 
choice (here: File1) 

ii. Detecting Options: select Detect a set of files in the specified 
folder, click on the  icon and create a folder on your hard drive 
where all the job files will be dropped (here: C:\pnl-nwatch-
drop\) 

Note: Please make sure you change the properties of the   
  pnl-watch-drop folder. Go to the directory where the 
  folder is located, right-click on the folder, open the  
  Sharing tab and select Share this folder. Under   
  Permissions make sure you assign FULL CONTROL  
  to the user(s). Close the properties windows. The folder  

  icon should look like this: . 

iii.  Execution Event: select Automatically detect changes in the 
folder.  

6. In the open window Trigger Properties, click on the Variable tab. 

7. Select Show internal variables. The window will show all internal 
variables. 
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8. Select the variable DataFileName. 

9. Open the Actions tab and click on the Properties button. The Actions 
Editor  window will open. 

10. Double-click on Run job under Action Types/ Labeling. The window 
Action Properties [Run job] will open.  

11. Select Variable job file name and DataFileName. Click on the OK 
button twice. 

12. Click on the OK button to close the window Trigger Properties. 

 

 

 

 

 

 

 

 

 

 

 

 

Now you have established a JOB file trigger with GalleryWatch. In the 
next step you create a form (.OFF) file with the correct file properties. 

 

(JOB) TCP/IP Trigger  

A TCP/IP trigger works similar to a JOB file trigger. The Mobile Device 
sends the job file to GalleryWatch trough the TCP/IP. GalleryWatch 
accepts the incoming file on a pre-defined TCP/IP port and processes the 
label printing on the GalleryWatch printing server. 

To set up a JOB file trigger with GalleryWatch, do the following steps: 

1. Open GalleryWatch (Go to Tools/ GalleryWatch in the menu bar of 
your open GalleryWatch software). 

 
GalleryWatch with File Trigger 
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2. Select New in the File menu or click on the icon  in the standard 
toolbar. 

3. Save the new configuration file as pnl-nwatch.mis. 

4. In the File menu bar, go to Edit/ Add Trigger/ TCP/IP…  or click on 
the icon  in the standard toolbar. 

5. Select the following options: 

i. TCP/IP Trigger Options: enable trigger and select file name of 
your choice (here: TCP/IP1) 

ii. Detecting Options: Enter port number of the computer/ server 
where GalleryWatch is running (here: 1027). 

iii.  Execution Event: select When client disconnects.  

6. In the open window Trigger Properties, click on the Variable tab.  

7. Select Show internal variables. The window will show all internal 
variables. 

8. Select the variable DataFileName. 

9. Open the Actions tab and click on the Properties button. The Actions 
Editor  window will open. 

10. Double-click on Run job under Action Types/ Labeling. The window 
Action Properties [Run job] will open.  

11. Select Variable job file name and DataFileName. Click on the OK 
button twice. 

12. Click on the OK button to close the window Trigger Properties. 
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Now you have established a TCP/IP trigger with GalleryWatch. In the next 
step you create a form (.OFF) file with the correct file properties. 

5.2.3 Create Form (.OFF) File for Distributed (Prin t Server) 
Printing Method 

Before you print labels using the GalleryWatch printing server, change the 
form file pocketnl-form.off you created above in the following two ways: 

�  Add a Select Printer combo box with GalleryForm so that you can 
pick the printer of your choice when you send the print job with your 
Mobile Device. 

�  Change the form properties with GalleryForm to enable distributed 
(print server) printing with your Mobile Device. 

Open GalleryForm on your desktop computer and do the following steps: 

1. Open the file pocketnl-form.off (see above). 

2. In the menu bar, go to Data/Variables… The window Variables will 
open. 

3. Click on the Add button. A new window will open. 

4. Enter Printer  in the Name text box click on the OK button. 

5. Click on the Close button to close the Variables window. 

GalleryWatch: TCP/IP Trigger 
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6. On the toolbox menu click on the Combo Box button and select 
Existing Variables/ Printer. Place the combo box object on the form.  

7. Double-click on the printer combo box. The window Combo Box 
Properties will open. 

8. Open the Values tab and click on the Edit  button. A new window Edit 
items will open. 

9. Select Use names of installed printers from the drop-down menu and 
click on the OK button. The Values tab of the Combo Box Properties 
window will show all the printer drivers you have installed on your 
computer. 

10. Select and delete the printer drivers you do not want to use with your 
Mobile Device. Click on the OK button to close the window. 

11. On the toolbox menu click on the Text button and place the text object 
on the form above the printer combo box. A new window Text 
Properties will open.  

12. Enter Select Printer in the Contents tab and click on the OK button. 

13. Double-click on the Print  button of the form. The window Button 
Properties will open. 

14. Open the Actions tab and click on the Edit  button. The window Actions 
Editor  will open. 

15. Select Set printer under Action Types and drag Set printer to the right 
window panel. Place Set printer under the first action For every label. 
The window Action Properties [Set printer] will open. 
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16. Select Variable printer name and select the printer variable. 

 

 

 

 

 

 

 

 

 

 

 

 

 
GalleryForm: Set Printer Action Properties 

 
GalleryForm: Actions Editor Set Printer Variable 
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17. Click the OK button three times to close all button properties windows. 

18. Save the form by clicking on the  button or select command Save 
from the File menu. 

TIP:   If the printer you selected on the label template is connected to  
  your desktop computer, test printing the form from your desktop 
  computer and do the following: 

a. Run the form by clicking on the  button or selecting the 
Run command in the Design menu. 

b. Type in the value for the first variable field (prompt5) and 
select the item from the Combo Boxes.  

c. Select the printer you want to print the label with. 

d. Click on the Print  button to print the label.  

e. Click on the Quit  button to close the running form. 

 

To change the form file properties using the JOB file option, do the 
following steps: 

1. Go to File/Form Properties… The window Form Properties will open. 

2. Open the Distributed Printing tab and select the following: 

i. Enable distributed printing 

ii. Save commands to .JOB file 

3. Enter the path to your drop folder that you created with GalleryWatch 
above and add the file name pnl-nwatch.job (here: \\dhb61851\pnl-
nwatch-drop\pnl-nwatch.job). [Please note that the path name starts 
with your computer/ server name, which is in this example dhb61851]. 

4. Click on the OK button and save the form by clicking on the  button 
or select command Save from the File menu. 
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To change the form file properties using the TCP/IP option, do the 
following steps: 

1. Go to File/Form Properties… The window Form Properties will open. 

2. Open the Distributed Printing tab and select/ enter the following: 

i. Send commands via TCP/IP protocol 

ii. Host: enter host IP address of the computer/ server where 
GalleryWatch is running (here: 192.168.0.101) 

iii.  Port: enter port number of the computer/ server where 
GalleryWatch is running (here: 1027) 

3. Click on the OK button and save the form by clicking on the  button 
or select command Save from the File menu. 

 

 

 

 
GalleryForm: Form Properties JOB File Option 
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5.2.4 Print Labels with the Distributed (Print Serv er) Printing 
Method 

To print labels with your Mobile Device using the distributed (print server) 
printing method, do the following steps: 

�  Make sure GalleryWatch is running with the settings you established 
above Setup GalleryWatch for Distributed (Print Server) 
Printing Method . 

�  Synchronize the modified form (.OFF) file above (here: pocketnl-
form.off;  see chapter Synchronize with Synchronization 
Manager). 

�  Change properties on your Mobile Device as discussed in chapter 
Select Communication Port between Print Server and Mobile 
Device.  

�  Open the form (.OFF) file on your Mobile Device, enter the data you 
want to print and tab the Print  button. 

 
GalleryForm: Form Properties TCP/IP Option 
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To change properties on your Mobile Device, do the following steps: 

1. On your Mobile Device, tab on Start/ Programs/ Pocket Label 
Gallery/ Pocket Label Gallery (or Pocket GalleryForm). Pocket 
Label Gallery (or Pocket GalleryForm) will open. 

2. Tap Options/ Preferences and the window Preferences will open. See 
figure below.  

3. Enter the default folder with the label files on your Mobile Device 
(Pocket Label Gallery uses My Labels on default).  

4. Select either JOB File or JOB TCP/IP and enter the required 
information for path/ name or host/ port. Make sure you enter the same 
information as discussed in chapter Create Form (.OFF) File for 
Distributed (Print Server) Printing Method . See example in figure 
below.  

 

 

 

 

 

 

 

 

 

 

 

 

5. Tap the OK button to close the window. 

 

 

 

 

 
Distributed Printing: JOB TCP/IP 

 
Distributed Printing: JOB File 
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To print the label with your Mobile Device using Pocket GalleryForm, do 
the following steps: 

1. Transfer the form (.OFF) file with the Synchronization Manger to your 
Mobile Device (see above). 

2. On your Mobile Device, tap on Start/ Programs/ Pocket Label 
Gallery/ Pocket GalleryForm. Pocket GalleryForm will open. 

3. Tap File/ Open form/ My Documents/ My Labels/ and select the 
.OFF file (here: pocketnl-form.off).  

4. Tap the OK button. You will see the following information on the 
screen:  

 
 

5. Tap the run icon (green arrow) or tap File/Run form. A new window 
will open showing the form with the variable combo boxes (see figure 
below). 

6. Enter and select the required information.  

7. Tap the Print  button to print the form. 

 

 

 

 

Distributed Printing: Open Form 
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Distributed Printing: Run Form Distributed Printing: Enter Data 
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6. Trouble Shooting with Pocket 
Label Gallery 

The following chapter will not all address all the error messages you might 
encounter using Pocket Label Gallery. If you do not find an answer to your 
error, go to the support section of the Label Gallery Web site at 
www.satoworldwide.com or contact the vendor you purchased the Label 
Gallery software. 

6.1 Exporting and Synchronization Issues 

Issue:  Export to Pocket PC with Label Gallery Plus does not work. 
No .LVR and .PNL files are created in the My Labels 
folder. 

Solution: Before you export the .PNL file, make sure that the data  
   input fields are empty. If you have printed the .LBL file  
   with entered data or printed a form .OFF file that bases on 
   the .LBL file, the label .LBL file stores the input data in the 
   memory. In such a case, you need to close and open the  
   .LBL again before you export it to the Mobile Device. 

 

Issue:  Export to Pocket PC shows the error message: “True type 
   text must not be variable!” 

Solution: If you want to print labels with your Mobile Device using 
   Pocket Label Gallery, remember that you must use native 
   printer fonts for variable objects. See chapter Designing  
   Labels for Pocket Label Gallery. 

 

Issue:  Cannot synchronize selected file in the Synchronization  
   Manager. 
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Solution: Connect the Mobile Device to your desktop computer (must 
   have established connection) and select the Mobile Device 
   (click on icon in the device bar) before you click on the  
   synchronize icon. 

 

Issue:  Error message “Another instance of application already  
   running…” 

Solution: Close down all Label Gallery applications, restart your  
   computer and open Synchronization Manager again.  

 

Issue:  Synchronization Manager shows the device as Offline even
   though Mobile Device is connected to the desktop   
   computer. 

Solution: Close all open programs and re-start your computer. Open 
   Synchronization Manager and add Mobile Device to the  
   Synchronization Manager again (follow wizard). 

 

Issue:  Synchronization of form file with the Synchronization  
   Manager does not work. 

Solution: Check the following options: 

1. Connect Mobile Device to your desktop computer 
and select the Mobile Device (click on icon in the 
device bar) before you click on the synchronize icon. 

2. If the form .OFF file you want to synchronize is NOT 
connected to a database, copy the file in the 
synchronization folder of your Mobile Device and 
synchronize the file with ActiveX. 

3. If the form .OFF file you want to synchronize is 
connected to a database, close all open programs, 
restart your computer and synchronize the .OFF file 
with the Synchronization Manager again. 
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6.2 Label Printing Issues with Mobile Device 

Issue:   Label does not print or wrong variable prompts are  
   displayed. 

Solution:  Transfer label to the Mobile Device again but follow these 
   steps: 

1. Delete the Pocket Label Gallery files (.PNL, .LVR, 
and .OFF files) from the memory or turn off the 
Mobile Device (suspend for Windows .Net devices) 

2. Delete files in Synchronization folder on your 
desktop computer 

3. Export file from Label Gallery Plus 

4. Synchronize with Mobile Device and start printing 
from Mobile Device 

 

Issue:  Mobile Device displays error message: 
“Directory(\\computername\dropfolder\) is not accessible or 
does not exist!” 

Solution: If you are using the JOB file trigger option for distributed 
  (print server) printing method (see chapter Setup   
  GalleryWatch for Distributed (Print Server) Print ing 
  Method) create or change the settings of the folder on your 
  hard drive where all the job files will be dropped (for  
  example: C:\pnl-nwatch-drop\ ).  

To change the folder’s preferences, do the following steps:  

1. Go to the directory where the folder is located (for 
example: C:\pnl-nwatch-drop\). 

2. Right-click on the folder. 

3. Open the Sharing tab and select Share this folder. 

4. Click on the Permissions button and assign FULL 
CONTROL  to all the users. 

5. Click on the OK button twice to close the properties 

windows. The folder icon should look like this: . 
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Issue:  Mobile Device displays error message: “Cannot write to file 
   (\\computername\dropfolder\jobfile.job)!” 

Solution: See above. Check sharing and permission rights for the  
   drop folder. 

 

Issue:  Mobile Device displays error message: “Connection to the 
   server (xxx.xxx.x.xxx:xxx) cannot be established.” 

Solution: Check the following setup configuration: 

1. Enter the correct server IP address and port number 
of the computer/ server where GalleryWatch is 
running under options/preferences of your Mobile 
Device. 

2. Enable or run the TCP/IP trigger setup in 
GalleryWatch (for example, check the box in the row 
of your TCP/IP trigger name in GalleryWatch; see 
GalleryWatch figure above). 

 

Issue:  Mobile Device displays error message: “Engine Error!  
   Cannot use this function from selected type of printing.” 

Solution: Check the preferences under options on your Mobile  
   Device and make sure that you have selected the correct  
   port (for example, JOB TCP/IP  versus TCP/IP port) for  
   your selected printing method (direct versus  distributed  
   printing). 
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7. Technical Support 

If you experience any technical difficulties using the Label Gallery 
software, refer to the on-line help and User Guides available on the Label 
Gallery CD. You will find a comprehensive How to section that explains 
how to use the Label Gallery software. 

7.1 Online Support 

You can find the latest builds, updates, workarounds for problems and 
Frequently Asked Questions (FAQ) under the Support section on the 
product website at,  

http://www.satoworldwide.com/labelgallery/index.htm  

If you cannot solve the problem on your own, please contact your local 
software vendor or SATO representative offices. 
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Contact Information 

 

For more information please refer to: 

Support FAQ: 

http://www.satoworldwide.com/labelgallery/support_faq_general.htm 

Label Gallery FAQ (eHelp): 

http://www.satoworldwide.com/labelgallery/support_ehelp.htm 
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7.2 Contact Information 
 

Sato International Pte. Ltd. 
438A, Alexandra Road, #05-01/02 
Alexandra Technopark, 
Singapore 119967 
Tel: 65-6271-2122 
Fax: 65-6271-2151 
Sales: 
sales@sato-int.com 
Technical Support: 
softwaresupport@sato-int.com 
Website: 
http://www.satoworldwide.com 
 

 Sato America Inc. 
10350 Nation Ford Road Suite A 
Charlotte, NC 28273 
Tel: 1-704-644-1650 
Fax: 1-704-644-1662 
Sales: 
sales@satoamerica.com 
Technical Support: 
techsupport@satoamerica.com 
Website: 
http://www.satoamerica.com 

Sato UK Ltd 
Valley Road, Harwich, Essex England 
Co12 4RR, United Kingdom 
Tel: +44 (0) 1255-240000  
Fax: +44 (0) 1255-240111 
Sales: 
enquiries@satouk.com 
Technical Support: 
techsupport@sato-uk.com 
Website: 
http://www.sato-uk.com 
 

 Sato Europe NV 
Leuvensesteenweg, 369 
1932 Sint-Stevens-Woluwe,  
Brussels, Belgium 
Tel: +32 (0) 2-788-80-00 
Fax: +32 (0) 2-788-80-80 
Sales: 
info@be.satoeurope.com 
Technical Support: 
technical.support@be.satoeurope.com 
Website: 
http://www.sato-europe.com/ 
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Sato Deutschland GMBH 
Schaberweg 28, 61348 
Bad Homburg, Germany 
Tel: 49 (0) 6172-68180 
Fax: 49 (0) 6172-6818-190 
Sales: 
info@de.satoeurope.com 
Technical Support: 
softwaresupport@sato-deutschland.de 
Website: 
http://www.sato-deutschland.de 
 

 Sato Polska SP Z O. O. 
ul. Wroclawska 123 
55-015 Radwanice k/Wroc
awia 
Poland 
Tel: 48-71-381-03-60 
Fax: 48-71-381-03-68 
Sales: 
biuro@pl.satoeurope.com 
Technical Support: 
technical.support@be.satoeurope.com 
Website: 
http://www.sato-polska.com.pl 

Sato France s.a 
Parc D’Activities 
Rue Jacques Messager 
59175 Templemars, France 
Tel: 33-3-20-62-96-40 
Fax: 33-3-20-62-96-55 
Sales: 
info@fr.satoeurope.com 
Technical Support: 
technical.support@be.satoeurope.com 
Website: 
http://www.sato-europe.com 
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Sato Asia Pacific Pte. Ltd. 
438A, Alexandra Road, #05-01/02 
Alexandra Technopark, 
Singapore 119967 
Tel: (65) 6-271-5300 
Fax: (65) 6-273-6011 
Sales: 
sales@satoasiapacific.com 
Technical Support: 
technical@satoasiapacific.com 
Website: 
http://www.satoasiapacific.com 
 

 Sato Shanghai Co. Ltd. 
307 Haining Road, ACE Building 
10TH Floor, Hongkou Area, 
Shanghai, China 200080 
Tel: (86) 021-63068899 
Fax: (86) 021-63091318 
Sales: 
sales@satochina.com 
Technical Support: 
technical@satoasiapacific.com 
Website: 
http://www.satochina.com 
 

Sato Auto-ID Malaysia Sdn. Bhd. 
No.25, Jalan Pemberita U1/49, 
Temasya Industrial Park 
Section U1, 40150 Shah Alam, 
Selangor Darul Ehsan 
Tel: 60-3-7620-8901 
Fax: 60-3-5569-4977 
Sales: 
sales@satosms.com.my 
Technical Support: 
technical@satoasiapacific.com 
Website: 
http://www.satoasiapacific.com 
 

 Sato Auto-ID (Thailand) Co. Ltd. 
292/1 Moo 1 Theparak Road, Tumbol 
Theparak, Amphur Muang 
Samutprakarn 10270 
Tel: 662-736-4460 
Fax: 662-736-4461 
Sales: 
sales@satothailand.co.th 
Technical Support: 
technical@satoasiapacific.com 
Website: 
http://www.satoasiapacific.com 
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8. Index 

A 

ActiveSync. See Synchronize 

ActiveX server. See Printing Method, Print Engine 

B 

Bluetooth, 33 

C 

Client Access License (CAL). See Registration 

COM Port, 32 

Combo Box. See Object 

Concatenation. See Functions 

Contact, 59, 60 

Currency Exchange. See Functions 

D 

Database Connection, 22 

Date Addition. See Functions 

Demo Mode. See Label Gallery 

Design, Label. See Label Design 

Direct Printing. See Printing Method 

Distributed Printing. See Printing Method 

E 

EAN.UCC 128. See Functions 

Export. See Synchronize 

F 

Form. See Label Design, Form 

Functions, 14 

Concatenation, 14 

Currency Exchange, 14 

Date Addition, 14 

EAN.UCC 128, 14 

Internal Printer Clock, 14 

Internal Printer Counters, 14 

Linear, 14 

Subset, 14 

G 

GalleryDriver, 16 

GalleryMemMaster. See Label Gallery 

GalleryWatch. See Label Gallery, Distributed Printing 

I 

Installation, 6, 7 

Installation Wizard, 7 

Transfer .CAB File, 9 

Internal Printer Clock. See Functions 

Internal Printer Counters. See Functions 

IrSIR port, 33 

J 

JOB File, 40, 48 

JOB TCP/IP, 40 

L 

Label Design 

Form, 19, 45 

GalleryForm, Using, 18 

Label Gallery Plus, Using, 15 

Overview, 13 

Label Gallery 
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Demo Mode, 10 

GalleryForm, 18 

GalleryMemMaster, 4 

GalleryWatch, 4 

Label Gallery TruePro, 4 

Label Gallery TruePro. See Label Gallery 

Label Printing. See Printing Method 

LASP Port, 32 

Linear. See Functions 

M 

Mobile Device 

Printing (with Pocket GalleryForm), 36 

Printing (with Pocket Label Gallery), 35 

Printing, Direct, 33 

Setup and Testing, 4 

Windows CE, 4 

N 

Native Font, 15 

O 

Object 

Combo Box, 20 

GalleryForm, Supported with, 18 

P 

Pocket GalleryForm, 18, 36 

Pocket Label Gallery 

Overview, 3 

Print Server Printing. See Printing Method, Distributed 

Printer Driver. See GalleryDriver 

Printing. See Printing Method 

Printing Method 

Direct Printing, 13, 32, 34, 36 

Distributed Printing, 3, 39, 41, 50 

Print Engine, 3 

R 

Registration, 11 

Client Access License (CAL), 11 

Resident Font. See Native Font 

S 

Subset. See Functions 

Support, 58 

Synchronization Manager. See Synchronize 

Synchronize 

ActiveSync, 16, 26 

Synchronization Manager, 29 

System Requirements, 6 

T 

TCP/IP, 32, 49 

Transfer Files. See Synchronize 

W 

Windows CE. See Mobile Device 

 


